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January 15, 2010

Solo 4.6 Release Notes

This release contains a number of new features, as well as enhancements to the user
interface and overall performance. Together these changes help make Solo the most
powerful report production application on the market today.

Please forward any comments or questions to: support@axoninc.com.

We thank you in advance for your feedback and continued support,

The Solo Development Team

 

Solo 4.5 Feature Highlights

Expanded Export Capability: Export documents directly to native Microsoft
PowerPoint files and other common file formats.
NOTE: PowerPoint version 8 must be on the
computer rinnign Solo.   

Improved User Interface: New Tool Tips, revised functions and other
interface improvements make Solo even easier to
use.

Improved Template Use: Improved Template interface allows you to preview
templates on screen, annotate your templates with
descriptions which guide the decision process, easy
keyboard navigation. 

Improved Charting: Get access to chart data with a single click. Data
window improvements make data manipulation
easier.

Improved Text Features: "Name" text for quick and easy automatic
placement to eliminate retyping of commonly
repeated text such as names and addresses. 

Improved Page Identifiers: Improved range of unique page and document
tracking information.

Other Enhancements: Several additional "behind-the-scenes" productivity
and performance enhancements.

Axon Incorporated 21 Walmsley Road Sales: Support:
Darien, CT 06820 Phone: (203) 662-8713 (203) 662-8713
USA Fax: (203) 662-5878 (203) 662-5878
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(Updated to include Solo 4.6.3 changes)
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SOLO 4.6.3

This is a maintenance release of the Japanese localized version of Solo which does not
include new features. It does include improvements and fixes to user reported problems
with previous versions of the software.

A complete Change History can be found in the Solo 4.6 directory in the Program Files
folder once this release has been installed. Alternatively, you can obtain a copy from the
Axon, Inc. web site at:

http://www.axoninc.com/site/pages/update_solo/select_version.html

1.  New Features and Enhancements in Solo 4.6.3 
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NEW CHART VARIATIONS

Two new chart variations have been added: 
- Mekko charts, which are used to illustrate revenue or cost contributions to a total

across categories and their components. 
- Stacked Cost Curve (Stack.s), which compares production capacity and costs for

different producers and their products within an industry, has been added as a
new Cost Curve variation.  

Entering Data in a Mekko chart

Mekko chart data is entered using X&
Y coordinate pairs. The X value is
entered in the first data column, the Y
value in the second. Additional Y
values are entered in trailing data
columns to "stack" values on top of
each other to create the segments
contributing to the 100% total. The
data window at right illustrates an
example. 

Entering Data in a Stacked Cost Curve chart

Data for the Stacked Cost Curve is entered exactly like the Mekko chart. When
displayed the additional Y values are stacked but do not total to 100%. 

2.  New Features in Solo 4.5.2 
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NEW CONCEPT TEMPLATES 

Five new templates were added to the Relationships category of Concept Templates.
These are Concentric 1, Concentric 2, Concentric 3 and Radar 1 and Radar 2 

NEW NAMED OBJECT FEATURES

Two new features have been added to the Name Selected Object dialog box. 

These are: "Automatically Accept Changes" and "Automatically Unlink When
Changed". Only one can be selected at time. These were added to allow users to
construct more powerful and flexible templates.

When "Automatically Accept Changes" is selected it allows the user to create a form,
i.e., a page containing copies of the Named Objects used in a Template File or
document,  for controlling the settings and attributes of Named Objects without being
prompted for permission to make each change. 

"Automatically Unlink When Changed" is the preferred setting for any object in
included in a template which might be centrally controlled. The user can override
settings without being prompted for permission to change the object globally throughout
a document.
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2. New Features in Solo 4.5.2 (continued)
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COPYING AND PASTING OBJECT ATTRIBUTES 
AND NAMED OBJECT LINKS 

To aid in the faster creation of objects needed during Template File development or for
the creation of an individual page, you can copy and paste object attributes and Named
Object links.

To copy the object or any of its attributes, select the object and press the right mouse
button (on the Macintosh you should Control-click on the object). This displays a
Contextual menu. Drag the cursor down to the "Copy" menu entry. You can choose
between copying the object, all of its attributes or a subset its attributes using the
hierarchical options. 

Once you have made your selection you can paste the object, its attributes to another
object or selection of objects.

To copy Named Object links, select a Named Object and open the Contextual menu as
described above. You will see that the "Links...' selection is activated. 

Select the link you wish to copy. A copied link can only be pasted to an object of the
same type. If you attempt to paste a link to an object of a different type a warning
message is displayed. If several objects are selected, pasting the link will only affect
those objects of the same type.
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2. New Features in Solo 4.5.2 (continued)
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IMPROVED TABLE INTERFACE

The Table tool has undergone several modifications relating to cell selection and cursor
sensitivity. 

Cell Selection: Once a range of cells is selected you can change the current cell by
clicking on any cell in the selection without losing the selection. This makes it possible
to enter edit mode by clicking on text in one cell in a range of selected cells, and still
preserve the cell selection. Previously this was only possible by pressing the Enter key.

If a dialog is opened in front of selected cells, the selection is maintained so the user can
"see" which cells will be affected by changes in the settings to the dialog.

Cursor Sensitivity: To make it easier for the user to see how a click is going to be
interpreted the cursor "sensitivity" is improved to accurately display the text insertion
cursor when over text in a selected cell. The "tail less" pointer is displayed when over
the areas in the cell where the user can double click. When over unselected cells, the
"tail less" pointer is always displayed, because a click will first select the cell.

With the text tool selected the user must click in the upper left quadrant of the table cell
to enter text edit mode. When the mouse is over this text area the text insertion cursor
will be displayed, anywhere else the "tail less" cursor is displayed indicating that the
click will select the cell rather than enter text edit mode.

Entering text edit mode with the pointer tool now works the same way, except that the
first click selects the cell (if not already selected), and then the text insertion cursor is
displayed when moved over the empty cell's text edit area i.e., the upper left quadrant of
the cell.

Column Width and Row Height: To change the column width or row height for all
columns or rows you now only have to select the table, WITH NO CELLS SELECTED, 
go the Table menu and change the desired column width or row height settings. The
change will affect all column or rows.

Modifying Cell Contents: Solo now allows for the modification of text alignment and
applying named paragraphs using the text ruler pop-up in tables when multiple cells are
selected. 

• Hold the Control and Alt keys when applying Named paragraphs 
(on the Macintosh hold the Command and Option keys). 

• Hold the Control key when changing other settings 
(on the Macintosh hold the Command key). 

Also NOTE:
A. Changing the Paragraph Format Pop-up Tab settings (First Row) will set the

default Tab Kind.
B. Inserting a Paragraph Format from the Named Paragraph Format Pop-up will only

insert a paragraph in the cell being edited.

Axon Incorporated 21 Walmsley Road Sales: Support:
Darien, CT 06820 Phone: (203) 662-8713 (203) 662-8713
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3. Changes and Improvements in Solo 4.5.2 
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General Improvements...
• Pictures containing certain pixel map resolutions now draw correctly. (Windows)
• Exporting tables to PowerPoint containing cells with line spacing set to 0 now works

correctly.
• Kanji text exported from Solo to PowerPoint now appears correctly in the PowerPoint

document.
• When exporting text to PowerPoint containing a mixture of fonts which name's start

with the same string of characters, e.g. "Arial" and "Arial Black", some text in the
PowerPoint document could end up with the incorrect font. This has been corrected.

• The initial dimensions and location of the Chart Data Window is improved.
• Under Windows 98/NT, dialogs update properly after performing a dragging

operation has been performed.
• Changing the location and size links of named line shapes is improved.
• Undoing the rotation of line shapes from Line Info dialog now works correctly.
• The scroll speed in the Page Editor, the Data Table and Clipboard Window is now

limited to a maximum rate to avoid scrolling "too fast" on newer (400 MHz) PCs.
• A problem with undoing the placing of a Template that contains named objects that

need to be resolved has been corrected.

Axon Incorporated 21 Walmsley Road Sales: Support:
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3. Changes and Improvements Solo 4.5.2 (continued) 
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EXPORTING SOLO DOCUMENTS TO MICROSOFT POWERPOINT

Windows Version Only - To PowerPoint version 8 or higher

Under Windows, Solo documents can now be exported directly to native Microsoft
PowerPoint documents. All pages (or objects) are exported directly to a PowerPoint file
with all object positioning and precision intact. 

Use the following procedure:
1 In the Storyboard view, select the page(s) to be exported. 
2 Choose the "Export" command from the "File" menu. 
3 Click either the "Selected Pages" or "All Pages" radio button at the bottom of the

dialog box. 
4 Select the "MS-PowerPoint (*.PPT)" option from the file type pop-up menu at the

bottom of the dialog box. 
5 Use the dialog to navigate to the desired storage location.
6 Enter a name for the new file. 

(You should leave the .PPT file extension in the file name). 
7 Click the "Export" button to create the PowerPoint file. 

New Export File formats

Solo now supports exporting pages using the following file formats:
• MS-PowerPoint (*.PPT)
• Graphics Interchange Format (*.GIF)
• JPEG Interchange Format (*.JPG)
• Portable Network Graphic (*.PNG)

Axon Incorporated 21 Walmsley Road Sales: Support:
Darien, CT 06820 Phone: (203) 662-8713 (203) 662-8713
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Exporting Specific selected objects to PowerPoint

In the Page Editor view you can export a subset of the page contents to PowerPoint. For
example, you may only wish to export a single chart or graphic and not the entire
contents of the page. 

Use the following procedure to export the specific selected objects:
1 In the Page Editor view, select the objects to be exported by Shift-clicking on

them. 
2 Leave the objects selected and choose the "Export" command from the "File"

menu. 
3 Select the "MS-PowerPoint (*.PPT)" option from the file type pop-up menu at the

bottom of the dialog box. 
4 Use the dialog to navigate to the desired storage location.
5 Enter a name for the new file. 

(You should leave the .PPT file extension in the file name). 
6 Click the "Export" button to create the PowerPoint file.

Known Limitations

In developing the Solo to PowerPoint export feature we found the following limitations:
1 Condensed and extended text style formats are not supported by PowerPoint.
2 PowerPoint 8 defaults to Black and White printing. To properly print documents

containing gray scale or color, this option must be turned off in the Print Job
dialog box.  For example, if it is not turned off, tables with no color set for the
border it will print with a "border".

3 Text objects with complex formatting in Solo may change when exported to
PowerPoint. In the export process, Solo attempts to preserve all paragraph
formatting, however PowerPoint's paragraph formatting may not accurately
translate all Solo paragraph formats.

4 Data driven charts are depicted properly but are no longer linked to a data set. 
5 Arrowheads on closed polygons are not supported by PowerPoint.
6 Tab leaders are not supported by PowerPoint.
7 Some Macintosh Picts cannot be read by PowerPoint. When PowerPoint is unable

to add a picture an alert is displayed with an out of memory message. 
- Clicking OK ignores the picture and continues exporting. 
- Clicking Cancel stops the export process. 

8 PowerPoint 97 under Windows does not support fractional character spacing.
9. A Solo document with multiple page set up(s) must be changed to have only one

set up at 100%. PowerPoint does not support different page set-ups in a single file.
Vertical and horizontal pages must be exported to separate files.

Axon Incorporated 21 Walmsley Road Sales: Support:
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5. Solo Release 4.5: New Features (continued)
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FRACTIONAL CHARACTER WIDTHS 

For Expert Users Only

A new "Fractional Character Spacing" application preference has been added to the
application preference dialog box. This preference controls how text is displayed and
printed.

Solo was designed to take advantage of the more pleasing character spacing possible
through the use of fractional character spacing. When exporting Solo formatted text to
other applications (such as PowerPoint) which do not support the use of fractional
widths, the text may not display exactly the same. To make Solo display the text the
same as PowerPoint, you can turn off the fractional widths feature in Solo.

NOTE: Axon strongly suggests that you do not change this setting as its improper use
can cause unintended incompatibilities when sharing documents with other Solo users.

To control fractional widths in the current document, use the new "Properties" menu
item.

Fractional Character spacing properties are stored on a document by document basis. As
such, there are a few things to keep in mind. 

• When copying and pasting pages from one document to another, the character width
settings of the target document are honored. Pages originating from a document
where Fractional Character spacing was ON that are pasted into a document where
Fractional Character spacing is OFF may exhibit different line wrapping
characteristics (and vice versa). 

This may require an inspection of the document to make sure that pages display and
print as you require them. 

Fractional
Widths
Preference
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4.  Solo Release 4.5: New Features (continued)  
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SELECT CELLS COMMAND

A new Select Cells command has been added to the Edit menu. 

The leftmost pop-up menu provides three basic search criteria for selecting cells:
Modified since, Date modified, and Cells. 

The rightmost pop-up changes to provide additional criteria depending on which of the
three basic criteria is specified. 

TOOL TIPS

Added support for context sensitive tool tips which display the associated command or
function of a particular command or tool icon. 

When the pointer is positioned over a command or tool icon, after a 1.5 second delay
the tip for the icon is displayed. The tip will disappear after 4 seconds. 

In the Application Preferences dialog box there is a new "User mode" section that
allows you to specify a user level. Choosing the "Expert" mode turns the display of the
Tool Tips Off. 

User Mode Preference Settings

Tool Tip
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4.  Solo Release 4.5: New Features (continued)  
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NAMED TEXT

Solo now provides the ability to create "Named Text". 

This new feature is useful for inserting standard text content (e.g., names, addresses,
etc.) without having to retype it from document to document. Named Text objects are
created in the same manner as other named objects. Use the new check box (illustrated
below) to create "Named Text". 

Inserting Named Text
Named Text can be inserted while in text edit mode. Named Text is displayed in
Italics the Named Paragraph pop-up menu. Selecting a Named Text entry in the list
inserts the contents of the Named Text object. 
For example, these Release Notes contain a Named Text object, –Axon Contact
Info, which in edit mode places Axon's standard contact information. Try using it on
an empty page in this document. 

Placing Named Text
Named Text objects are placed in the same manner as any other Named object.
Select the "Place Named Object" command from the "Templates" menu. This
displays the "Named Objects" dialog box. Select the Named Text object in the list
and click the "Place" button. A copy of the object will be placed on the currently
selected page(s). 

Named Object Check box Named Text Listing
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4.  Solo Release 4.5: New Features (continued)  
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CONTEXTUAL MENUS - RIGHT MOUSE BUTTON USE

In the Page Editor view, you can use the right mouse button to
display contextual menus. Contextual menus provide shortcuts to
commonly used commands. 

Position the pointer over an object and click the right mouse
button. A pop-up menu is displayed allowing you to select a series
of commands. 

Selecting the "Properties" command displays a dialog box that
governs the properties of the object. 

Macintosh version: Substitute a Control-click for a right-mouse click. Press and hold
the Control key and then click the mouse on an object to display the contextual menu. 
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4.  Solo Release 4.5: New Features (continued)  
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IMPROVED TEMPLATE LIBRARY INTERFACE

The Template Library dialog box has been redesigned to guide users through the
process of placing templates when building documents. Two new fields have been
added, the Description field and the Variation Preview field. In addition, the dialog
icons have been colorized and it can now be navigated using the keyboard. 

The new template variation preview field displays template miniatures allowing you to
preview a template before placing it in a document. It can be scaled allowing you to
view a single template miniature or 16 at a time. 

The new dynamic description field displays relevant information about the template
Categories, Types and Variations as they are selected in the dialog box. 

Placing Templates

The process of placing templates remains the same four step process:
1 Pick a page category
2 Choose a type
3 Select the appropriate variation
4 Click the "Place" button to place the template in the document

Built-in Versus User Entered Descriptions
• User defined templates can now have descriptions added to them for display in the

description field. This information is entered by the template designer when the
template is created to guide other users in the "best use" of a template variation. 
The Define Template dialog box has been modified to accommodate the entry of
variation descriptions. 

Description
field

Variation
Preview field

Preview
scaling
controls
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5. Solo Release 4.5: Changes and Improvements
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• As you click the various icons in the dialog box the description field dynamically
updates to display relevant information about the Category, Type and individual
Variation. 
All Category, Type and data driven chart Variation descriptions are built into the
Solo program and cannot be modified. 

Using The Variation Preview Field
• The Variation Preview field can be scaled to display either a single miniature or 16

miniatures at a time by using the two scaling buttons located above the field. 
• When there are more than 16 Variations, the vertical scroll bar on the right side of

the field allows you to scroll through the field. 
• When displaying a single miniature the scroll bar or arrow keys can be used to scroll

the field. 
• The Preview field can also be scaled up and down by pressing the Alt key and

clicking the mouse on an individual Variation. 

Navigating The Template Library Dialog Box

The Template Library dialog box is now divided into three fields and can be navigated
using the keyboard. 

• Pressing the Tab key will navigate between the Category, Type and Variation fields.
• Pressing Shift-Tab reverses the direction of field selection.
• The Arrow keys can be used to navigate within a field.

Axon Incorporated 21 Walmsley Road Sales: Support:
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6. Solo Release 4.5: Changes and Improvements (continued)
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MODIFIED DEFINE TEMPLATE DIALOG BOX

The Define Template dialog box has
been modified to accommodate the new
Template Description feature. Template
Designers can enter a template
description in the field at the bottom of
the dialog box. The description is then
displayed in the Template Library dialog
box description field when the template
is selected. 

When creating a template, a default
Type description is automatically
inserted in the field. The template
designer should either modify this
description or delete it and insert a
replacement. 

MODIFIED CHART LIBRARY DIALOG BOX

The Chart Library dialog box has been
modified to display template variation
descriptions. In addition, the Type and
Variation icons have been colorized. 

Navigating The Chart Library Dialog Box

The Chart Library dialog box is now
divided into two fields and can be
navigated using the keyboard. 

• Pressing the Tab key will navigate
between the Type and Variation
fields.

• The Arrow keys can be used to
navigate within a field.

IMPROVED CHART DATA WINDOW ACCESS

A new Data Window command icon has
been added to the chart frame that allows for
quick and easy access to a chart's data
window. Clicking the command icon
immediately opens the data window. 

Description field

Data Window Command Icon
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5. Solo Release 4.5: Changes and Improvements (continued)



Release Notes

Page 1911
/0

6/
20

01
  1

1:
06

 A
M

IMPROVED CHART DATA WINDOW

The chart Data Window has been improved
making it easier to select and manipulate data. 

Data Window Modifications
• Selecting rows and columns

- The Data window now contains row and
column headers making the identification
and selection of data more efficient.
Selecting a row or column is a simple
matter of clicking its header. 

- To select multiple rows or columns click and drag on a header. 
• Moving rows and columns

- It is no longer necessary to press and hold the shift key when using the row or
column selectors to move them. 
When the pointer is positioned over a row or column selector the pointer changes
to a double headed arrow. Simply click and drag the row or column selector to
change it's position in the window. 

• Tool Tips
- The data window also displays tool tips. 

MODIFIED STORYBOARD PRINT OPTIONS

The default settings for printing a
Storyboard have been changed as follows:

• Cells per page - changed from 12 to 30,
with 120 the maximum allowed. 

• Print Color - is now On by default to
insure the highest quality printed output. 

• Header - the default header is now
"Report Storyboard". 

All other settings remain the same as in
previous versions. 
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IMPROVED PARAGRAPH MARKERS

Paragraph Markers containing <place holder
text> are now automatically selected when they
are inserted in text objects. 

Place holder text is any combination of text that
is delimited by the < and > characters (e.g., <
place holder text>). 

When a new paragraph containing such a
marker is inserted the <place holder text> is
automatically selected. This document has been
formatted using this improvement. 

Paragraph markers can contain up to 255 characters. 

OTHER TEXT IMPROVEMENTS

Under Windows, the Condensed and Extended character styles are now available. 

REVISED KEYBOARD COMMANDS

Macintosh Only
• Under Macintosh System 8.5.x the keyboard command to select <text place

holders> has been changed to Control-Tab. 
Macintosh & Windows

• The Forward Delete key now functions as does the Backspace key when not in text
edit mode. 

IMPROVED PAGE NUMBERING

You can now specify the text color of page numbers. 

Place holder text used
as a paragraph marker
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IMPROVED PAGE IDENTIFIERS

The Page Identifiers dialog box
has been redesigned to improve
its use and several features have
been modified. 

Modifications
• Dialog Layout

- The dialog box has been
divided into 3 sections to
assist the user in it's use.

- The check box controlling
the page identifiers has
been moved to the lower
left of the dialog box. 

• New Identifiers
- 7 new page identifiers have been added. They are:

- Publication Date - Report Title
- Recipient - Charge Code
- Document Author - Office Location
- Document Type

- The information used by these 7 new identifiers is linked to their corresponding
fields (and Named objects) in the "Document Abstract" dialog box. This dialog
box is displayed by choosing the "Abstract" command from the "File" menu. 

Changes in Behavior
• In previous versions a single identifier could be placed in multiple locations on the

pages in a document. 
• In this version, an identifier can only be used once in a single location. 

- This is true for all identifiers with one exception, the "Free Form" edit field
identifier can be used in multiple locations on a page. This is the edit field at the
very bottom of the dialog box and can contain up to 255 characters. 

Modifying Page Identifiers
• To turn Page Identifiers off, un-check the check box in the lower left corner of the

Page Identifiers dialog.
• To change the location of an existing Page Identifier, deselect the identifier under

#3, select a new location under #1, then re-select the identifier and click OK. The
identifier will appear in the new location.

• To add an identifier, select the location (#1), set its attributes (#2) and then select the
identifier(s) you wish to see in that location. Click OK and the new identifiers will
appear on each page in your document.
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IMPROVED PICTURE FRAME OBJECT INFORMATION DIALOG BOX

The Picture frame "Object Info" has been
improved to make the substitution of frame
contents easier. It now provides additional
information about a frame's contents. 

To access this dialog box, double-click a
picture frame or right-mouse click a frame
and use the "Properties" command. 

The following additions have been made: 
• Change Button

- Clicking this button allows you to change the contents of the frame
• Ungroup button - Macintosh Pictures Only (PICT, PCT, PIC)

- Clicking the button "Ungroups" Macintosh pictures into distinct elements. 
• Data Size display

- Displays the data size of the picture
• Horizontal & Vertical dimensions

- Displays the size of the image in percent from it's original (source) size

In addition, the title bar displays the type of picture contained within the frame (Bitmap,
Windows Meta File, Macintosh Picture, etc.). 
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General Improvements...
• Improved the Slideshow display on large monitors. The Slideshow is now better

centered on the screen. 
• Lines can now be specified in fractional weights (e.g., 1.5 points). 
• Control-Period now cancels the startup of Solo under Windows. 
• The Template Library, Define Template, Chart Library dialog boxes are smarter about

their initial placement on screen. 
• Multiple lines of text in the chart data window are easier to select. 
• The Page Editor grid lines are now turned off when placing templates with attached

layouts in the Page Editor view to improve screen view. 
• Improved the display and printing of AM/PM page identifiers.
• Improved the pasting of text from MS Excel into Solo tables. 
• Improved the color handling of plot point labels in charts. 
• Improved the positioning of large font sized page numbers. 
• Improved the handling of pages on Windows machine where a printer driver has

never been selected or setup. 
• Improved the handling of templates containing pictures. 
• Improved option duplication of tables and charts. 
• Improved the importation of Windows Meta Files. 
• Improved the export of text, polygons and Meta File objects to PowerPoint files. 
• Improved the conflict handling of named objects after undoing the placement of

templates.
• Improved the scrolling speed of the data, page editor and clipboard windows.
• Improved the handling of chart baseline labels, they are now correctly repositioned

when using Alt (Option)-Backspace.  
• Improved the handling of log scales in charts. 
• Improved the display of dialog boxes under non-US systems. 
• Improved the display of the Page Identifiers dialog box when selecting it's various

options. 
• Corrected a problem when entering zero or negative numbers in fax software print job

dialog boxes. 
• Modified printing pages that are numbered before "1" in documents. To print pages

before page "1", you have four options: 
- In the Storyboard "Print Options" dialog box use the "Selected Pages" option.
- In the Storyboard "Print Options" dialog box use the "All" option.
- Select the pages in the Storyboard and use the "QuickPrint" command icon.
- Print pages individually in the Page Editor using the "QuickPrint" command icon.
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